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A tool for building the views for Control IQ
Document revision as of v4.0 beta
See Revision History at the end of the document

How to use the tool:
	
This document is not intended to indentify all of the features of this tool.  It is best to work with the tool (SAVE YOUR WORK OFTEN) and learn how it best works for you.

Every 'control' that you put on a screen takes 'resources'. The more you put on, the longer the page will take to load and to refresh.  Also, if you use 32mb jpegs and a lot of images, not only will it that take a lot of memory, it will take a long time to load (especially over a remote connection).  Bottom line: be sensible; put static labels and images within the background and when 8 colors can do the job, don't use 16,000 just because you can.  The “best-practice” is to put all of the titles, static images (all things that do not change) in the background image, and use this tool to define all elements that get refreshed.

This is not a drawing tool.  It is a placement tool.  Elements will have to be drawn in other applications like Fire Works, Paint or Photo-Shop.

Defining a new View:

Use the “Add Components” drop down at the top of the screen to add new controls to the view.  In general, it is a good idea to define the controls in the order that is displayed in the dropdown (Background first, then the larger controls and finally the smaller controls).

Controls Supported:
	Background Images	- For static images, schematics, floor plans
	Web Browsers		- Displays any website, or web based data
	Charts			- Displays data in Line, Bar, Pie Charts 
	Data Grids		- Displays tabular data
	Images		- Displays bitmaps, jpegs, Animated GIFs etc
	Labels			- Add tags, create clickable areas
	Buttons		- Standard Widows Button

Identifying Controls:

In previous versions you could define labels and images with transparent backgrounds (and nothing in the foreground).  This effectively created a clickable region on the screen that was not visible.  This also made it very difficult to “find” the control.  On the File dropdown there is now a selection to “Identify all Controls”.  This will temporarily draw a red-white box around each control so you can find it on the screen.  [Ctrl-A is a keyboard shortcut to accomplish the same thing]



Moving and Sizing:

When the mouse is hovered over a control, you can move and resize the control by left-clicking on the control and dragging the borders (for resizing) or the entire control (for moving it).  Some controls (like a 'Label') have an 'Autosize' property.  If Autosize=True, the size of the control is relative to the text that is displayed.  You will have to set 'Autosize=False' to be able to re-size the control.

Web Browser: The web browser control is a bit unique in that you must “grab” the control around the border to be able to move it.  This is easily observed as the cursor will change to a ‘hand’ when the control is moveable.
	
	Only one control may be ‘dragged’ or moved at a time.

Moving a control(s) can also be done by selecting one (or multiple) and using the arrows to move them 1 pixel at a time (nudge), shift+arrow keys will move the controls 5 pixels at a time. Single or Multiple controls can also be moved by left-clicking inside a selected control, hold and drag (v4.0)

Adding Controls:
Controls may be added by selecting them from the drop down at the top of the form, or by right clicking in an area of the working pallet (anywhere there is not a control present)

Screen Guide:
There is no size limitation for the views any longer.  In design mode, you will use all of the real estate of the screen.  On the File Dropdown menu, you can select different “Screen Guides” that will draw a rectangle on the screen showing the working area of the view at different screen sizes.  This box is for reference only.  Controls can be placed anywhere on the palette, but they will obviously not be viewable if they are outside the size of the users workstation. 
On the workstation (GUI) controls are located based on the center of the screen.
Views DO NOT scale based on the workstation screen.  It is up to the designer to design a view for the appropriate workstations.
As of v4.0 views DO scale to the screen-size of the workstation.  The views also support zoom and pan in GUI.  Settings for Maximum Zoom are set in Background & Defaults.
As views are enlarged / shrunk the controls will become ‘visible/invisible’ if their font size gets to small.  I.E.  If the scaled font size is less than 6pt, the control will disappear.  (Think Google Maps).  Settings for Minimum Font Size are set in Background & Defaults
With v4.0 final release, the Settings / Screen Guide will be removed


Editing Controls
A control is in edit mode when the red-white box appears on the control.  You can edit multiple controls at the same time but each will need to be “selected”.  Controls are selected by:
a. Left-Click or Right-Click on top of a control for a single control
b. Shift or Ctrl-Left-Click will add controls from the selected list
c. Ctrl-A will select all controls
d. File / Indentify all Controls
e. Add Components / View All / Select one or multiple controls
Once the control(s) is selected, Right-Click on any one of the selected controls.  If multiple controls are selected for editing, only the properties that are common to each of the controls will be editable.

Left-Click on the screen where there is no control will de-select all controls.

Copy/Paste:

After a control is placed on the palette, right-click on top of it to get into the property editor.  Once you have all the properties set the way you want, click on the “Edit” drop-down menu.  Clicking on "Copy" will place all of the properties for the control in a reserved location that can be "Pasted" into other controls.  
Notes:  
· Copy/Paste is not stored with the view
· Copy/Paste is retained between views until you exit CIQGUITool  
· If you make changes to the control that the Paste function is copied from those changes will be reflected in the Paste properties.

You may also select a control and press Ctrl-C to copy the parameter in the Paste Clipboard and Ctrl-V to paste the parameters in to selected controls.  As of v4.0 copy and paste will work between views.

Assign as Default/Paste the Default:

Works just like Copy/Paste including the notes with the following exceptions:
· If you do not “Assign as Default" for a control, a newly added control will use the previously added control of the same type for all of the default settings
· Once a Default is assigned, you may use it to modify existing controls by clicking on the "Paste the Default” from the edit menu.  Essentially this gives you two copy/paste holdings for each control type.

Show Real-Time Data:
GUI - Views is obviously the ultimate use for this tool, but you can see how the labels and images will react by selecting File / Show Real-Time Data.  Note that Left and Right-Click events will not be functional in this mode. 


Colors:
There are a number of areas where colors are selected, but the most comprehensive area is in Labels.  The first selection is “Defined Colors or ControlIQ”.  
ControlIQ
If you select “ControlIQ” the label will follow the coloring rules as defined by the Point (in Setup), and then by the coloring defined in the ReasonCodes table (in the database).  For instance an  Alarm  is White Text with Red Background.  Many of the reason code colors are defined as “Default” which in Tabular Data means Black text with a White background.  The Point coloring is defined in Setup as part of the point definition.  The hierarchy of coloring rules when a label is set to “Control IQ” is:
1. If the Point has colors defined, use them exclusively
2. If the Point colors are defined as “Default” then use the colors out of the ReasonCodes table
3. If the ReasonCodes table is “Default” then use the colors defined in the Background component “CIQ Default Foreground Color” and “CIQ Default Background Color”
Defined
If you select “Defined” the label will follow the coloring rules that are further defined in the properties of the label as “Defined – Text Color” and “Defined – Background Color”.  If there is an Alias defined, GUI will get the value and reason of the alias to further color the label.
If the Reason = Alarm or the Value is “true” based on the “Display Energized Colors when the Value is:” property, the label will use the “Defined – Energized Text Color” and “Defined – Energized Background Color”
AutoSave 
Autosave has now been implemented in v4.0.  Once you make an edit to a view, the view will be automatically saved every 2 minutes.
Parent / Child Relationships

One of the biggest features introduced in version 4.0 is the Parent / Child relationship of each control.  Prior to v4.0 the “background” was the parent and all controls (Background Image, Labels, Images, etc) were children to that single parent.  Controls that have a transparent attribute (background color), are transparent to their parent.  Therefore, all controls pre-version 4 were transparent to the background (usually SAI-Blue) and NOT to the image they are on top of.

Controls can now select the parent they belong to.  For example, the default parent is the Background Image (Panel1).  All controls placed in the view will default to this parent and will be transparent to image.  I.E. their transparency will now show the image instead of the background color.

However, any control can be the child of any other control.  By default, you can only select a parent that is larger in size of the control to be its parent but, (if there were reasons to do so), the parent could be re-sized after the fact.  Consider a view that has a background image.  Then add a large, transparent label on top of it (Label1).  (Its parent is the background image (Panel1).  Now place a number of labels on top of Label1, and make the parent to each “Label1”.  As you move “Label1”, all of the labels that are it’s children move with it.  If you delete Label1, all of the children are deleted (thank goodness for Ctrl-Z)

Queries
In charts and data grids, the data presented on the screen is based on the result of a query to the database.  There are volumes of books written about query design and syntax that we will not cover here, but a few examples can go along ways into showing the designer the capabilities of these controls.  Keep the queries simple. This is not a replacement for tabular data.
A simple query to show an alias and value
SELECT alias, txtValue FROM points_values
Would result in a DataGrid that looks something line this:
	alias
	txtValue

	AH1RAT
	57.3 deg

	AH1Sched
	On

	AH1Status
	Running

	OAT
	67.3 deg



You could also write a query to show points not communicating
	SELECT alias,txtValue,txtReason FROM points_values where reason =31 or reason=33
Obviously knowledge of the database would be good to know.  Queries can become more complex as in:
SELECT name as Point Name, txtValue as Value from points_values INNER JOIN points WHERE points_values.alias = points.alias.



Would result in a DataGrid that looks something line this:
	Point Name
	Value

	Air Handler 1 Return Air Temp
	57.3 deg

	[bookmark: _GoBack]Air Handler 1 Schedule
	On

	Air Handler 1 Fan Status
	Running

	Outside Air Temperature
	67.3 deg



For charts the Queries are even more complex
SELECT Hour(trnWhen)+(Minute(trnWhen)/60) as H, Round(Value) as V from History where Alias='edisonmeter' and Date(trnwhen) = Date(AddDate(Now(),Interval -2 day))

This would display a line on a chart for the meter recorded two days ago.  Note that queries for charts MUST define the X coordinate first and then the Y, and it can only return the two values.

It is always a good idea to develop the query in Navicat and then copy/paste it into CIQGUITool.

Notes:
Right Click – (In GUI) on controls, the right-click has pre-defined functions. Right-Click will present a menu to the CIQ GUI user (when the view is displayed).  The menu contains:

	Show Point Data	(in Tab Data)
	View Scheduled 	(if this is a “Sched” point type, otherwise this is not shown)
	Override Point Value
	Print			(this applies to the entire view)
		

Left Click – (In GUI) Some controls have a natural left click function.  
· Browsers natural left-click is to allow linking to other pages.  If you define left-click in GUITool that will take precedence over the controls natural left-click functions.
· DataGrids allow row and column selection (sorting) with the left click.  If you define left-click in GUITool that will take precedence over the controls natural left-click functions.

ALL images must already be in the database. This tool allows you to load images from disk and save them in the database, and to pull images out of the database and save them to disk for editing and copying.  See the "File" dropdown menu once the tool is up and running.
	
You MUST have an ODBC DSN setup as “ControlIQ” pointing to the database to use the tool. The development machine does not have to have IIS running (or installed), but it must be able to access the mySQL database whether local or remote.
	    




Mouse actions
	Left-Click on top of a control selects it for edit
	Left-Click NOT on top of a control de-selects all controls
	Left-Click held down on the control allows you to re-size it (if on the border)
	Left-Click held down on the control allows you to move it (if in the center)
	Left-Click held down Drag Down/Right Selects all controls within the box (not on top)
Left-Click held down Drag Up/Left Selects all controls that intersect the box (not on top)
Right-Click on the control brings up the control property editor (multiple controls)
Right-Click NOT on top of a control will bring up a selection to add new controls
	Double-Click on the control brings up the control property editor (single control)			
Keyboard Actions
	Shift with left-click selects / deselects multiple controls (one at a time)
	Ctrl with left-click selects / deselects multiple controls (one at a time)
	Ctrl-A selects all controls
	Ctrl-C copies the selected controls parameter to its paste holder
	Ctrl-D de-selects all controls
	Ctrl-I brings up the property editor
	Ctrl-M centers control in the middle of the screen (left to right only)
	Ctrl-N resets the screen for a new – erases all the controls on the screen
	Ctrl-O brings up the View Open selection box
	Ctrl-S brings up the View Save selection box
	Ctrl-V paste into selected controls, the parameter of the paste holder
	Ctrl-R toggles Show Real-Time Data
	Ctrl-P brings up the property editor
	Ctrl-Z Undo – the last 40 steps are saved
		Before Ctrl-V
		On entering the property editor
		On leaving the property editor
		Before control resize
		Before control move
		Before New View (Ctrl-N and File / New View)
		Before the add of any control
		Before the delete of an existing control

	
	Arrows – Move the selected control(s) 1 pixel in the selected direction.
	Arrows – With Shift - Move the selected control(s) 5 pixels in the selected direction

Definitions:
	Palette: Set when adding and editing the background.  The palette is the
		'canvas' that you have to work on.  ALL controls, including the
		background image are placed on the palette, and the location of 
		ALL controls are referenced to the Upper / Left corner of the palette
REGARDLESS of the size of the screen you are using for CIQGUITool.  The palette will show you its working size in the upper left corner of the working area and a border around.  Neither of these will show up on the final view as displayed in CIQ GUI Views.



Background Image: Set when adding and editing the background.  The
		background image is a 'template' that you lay on the palette to give
		an overall layout of the view.  Typically this is a floor-plan,
		or a schematic of a piece of equipment.  There is no requirement
		to have a background image.  IF a background image is defined,
		it will be centered on the palette EVEN IF IT IS BIGGER THAN the 
		palette.  It is most efficient to put as much on the background as 
		possible. All static labels, titles, lines, images, etc; anything that
		is not going to change as ControlIQ changes values.  This will speed 
		up the loading and decrease the amount of time it takes to refresh
		the screen.


	Controls:  These are the components that you put on the palette like
		buttons, images, data-grids, browsers etc.  These will always be
		on top of the background image (if defined)


	Class.Objects.Properties (COPs) – Referencing an Alias   (ciqAlias)
A 'COP' is a reference to a piece of information from Control IQ.  Some would refer to this as a handle.  The 'Class' component is the 'type' of data you are looking for.  In most cases this will be the point type

	Example:	AI.OATemp.Value

	In general you do not have to specify a class.
		OATemp.Value is the same as   AI.OATemp.Value
			
		If just the aliasname is given, .txtValue is assumed.
	
			OATemp  is the same as  AI.OATEMP.txtValue (or OATemp.txtValue)

	Image Files
		CIQGUITool supports the following file formats for images
			.bmp
			.gif
			.jpg / .jpeg
			.png 
			.tif / .tiff
			.wmf
			.ico / .icon










Versioning:		v2.4beta issued on 07/20/06
			v2.9beta updated on 11/14/07
			v2.9.2 beta update on 2/7/08
			v3.0 distribution on 11/1/2010	
			v3.4 distribution on 1/21/2012
				Added support for Ctrl-C / Ctrl-V
				Added support for Arrow movement of controls
				Added support for Right Click context menu
			V4.0 beta on 10/1/2013
				AutoSave every 5 minutes
				Scaleable Views
				    Background & Defaults – Maximum Zoom Factor
				    Background & Defaults – Minimum Fontsize
				Background & Defaults – Default Label Forecolor
				Background & Defaults – Default Label Backcolor
				Added support to lasso controls
				Fixed AutoScale on Chart Control
				Fixed Show Realtime data bugs
				Fixed Label Autosize
				Added parent / child relationships (transparency and Zorder)
				Export / Import Views 
				Makes .Bak of a view as you open it
				Allows deletion/removal of views from database
				Allows deletion/removal of images from database
				Added Settings / Color Picker to find color or any pixel 
				Ctrl-C / Ctrl-V survives between views
				Labels
					Added support for rotated text (any angle)
					Added support for multiple aliases (CSV)
					Added support for ticker type display
				Charts / Titles	
					?Now		10/01/2013 14:00:00
					?Today	October 1, 2013
					?Yesterday 	September 30, 2013
					?LastWeek 	September 22, 2013
					?LastMonth	September, 2013
					?ThisMonth	October, 2013
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